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 1
I n s t a l l i n g  t h e  C O M S O L  S o f t w a r e
This chapter provides detailed instructions for installing the COMSOL software 
for all different platforms and license types. You also find complete system 
requirements and license manager information. For most installations, the 
COMSOL Quick Installation Guide  that comes bundled with the DVD provides 
the basic instructions for installation on the Windows, Mac, and Linux/Sun 
platforms. Also see the COMSOL Support Knowledge Base on www.comsol.com 
for specific troubleshooting tips.
 1
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Gene r a l  T i p s

Welcome to COMSOL® 3.5a! Use this Installation and Operations Guide to install 
your COMSOL software products and start working with the packages. In addition to 
this manual, we supply many other resources to help you get the most out of 
COMSOL products. Among them are:

COMSOL Compatibility Notes

Accessible from the COMSOL Help Desk, this electronic PDF document provides an 
overview of changes throughout the COMSOL product line since the previous release 
that require special attention with regards to backward compatibility.

COMSOL Multiphysics Quick Start and Online Help

The easiest way for new users to get an overview of COMSOL Multiphysics’ 
capabilities and how to use them is to read the COMSOL Multiphysics Quick Start 
and Quick Reference manual. Also see the COMSOL 3.5a New Feature Highlights 
document, included with the DVD media, for an overview of the major new features 
in the 3.5a release. Further, the full COMSOL documentation set is available on your 
computer in the COMSOL help resources and as a set of PDF files.

Technical Support

If any questions arise regarding COMSOL software products—whether concerning 
installation, licensing, modeling, applications, or other technical questions—do not 
hesitate to contact your local COMSOL representative or send your questions to 
support@comsol.com.

Further, at www.comsol.com/support you can find a broad range of technical support 
resources including the searchable COMSOL Knowledge Base.

Typographical Conventions

All COMSOL manuals use a set of consistent typographical conventions that should 
make it easy for you to follow the discussion, realize what you can expect to see on the 
1 :  I N S T A L L I N G  T H E  C O M S O L  S O F T W A R E



screen, and know which data you must enter into various data-entry fields. In 
particular, you should be aware of these conventions:

• A boldface font of the shown size and style indicates that the given word(s) appear 
exactly that way on the COMSOL graphical user interface (for toolbar buttons in 
the corresponding tooltip). For instance, we often refer to the Model Navigator, 
which is the window that appears when you start a new modeling session in 
COMSOL; the corresponding window on the screen has the title Model Navigator. 
As another example, the instructions might say to click the Multiphysics button, and 
the boldface font indicates that you can expect to see a button with that exact label 
on the COMSOL user interface.

• The names of other items on the graphical user interface that do not have direct 
labels contain a leading uppercase letter. For instance, we often refer to the Draw 
toolbar; this vertical bar containing many icons appears on the left side of the user 
interface during geometry modeling. However, nowhere on the screen will you see 
the term “Draw” referring to this toolbar (if it were on the screen, we would print 
it in this manual as the Draw menu).

• The symbol > indicates a menu item or an item in a folder in the Model Navigator. 
For example, Physics>Equation System>Subdomain Settings is equivalent to: On the 
Physics menu, point to Equation System and then click Subdomain Settings. 
COMSOL Multiphysics>Heat Transfer>Conduction means: Open the COMSOL 

Multiphysics folder, open the Heat Transfer folder, and select Conduction.

• A Code (monospace) font indicates keyboard entries in the user interface. You might 
see an instruction such as “Type 1.25 in the Current density edit field.” The 
monospace font also indicates code.

• An italic font indicates the introduction of important terminology. Expect to find 
an explanation in the same paragraph or in the Glossary. The names of books in the 
COMSOL documentation set also appear using an italic font.
G E N E R A L  T I P S  |  3
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S y s t em Requ i r emen t s

General Requirements

These requirements are common to all platforms:

• A DVD drive for installation. If you need to install the software using CD-ROM 
media, please contact your local COMSOL representative

• TCP/IP on all platforms when using a license server

• Adobe Acrobat Reader 7.0 or later to view and print the COMSOL documentation 
in PDF format

The actual disk space needed varies with the size of the partition and the optional 
installation of online help files. The COMSOL installer informs you of hard-disk space 
requirements for a particular installation.

G E N E R A L  S Y S T E M  R E C O M M E N D A T I O N S

We recommend at least 1 GB of memory. The solutions of a few examples in the Model 
Library require substantially more than 1 GB of memory and some even a 64-bit 
platform.

F L O A T I N G  N E T W O R K  L I C E N S E S

Floating network licenses are supported on heterogeneous networks of Windows, 
Linux, Sun, and Mac computers. Both the license manager and the COMSOL 
application can run on either Windows, Linux, Sun, or Mac, and a single computer can 
run both of them.

COMSOL Multiphysics System Requirements for Microsoft Windows

G E N E R A L  S Y S T E M  R E Q U I R E M E N T S — W I N D O W S

Use Automatic Updates to keep your Windows system up-to-date. You can access it 
and turn it on from the Control Panel.
1 :  I N S T A L L I N G  T H E  C O M S O L  S O F T W A R E



S Y S T E M  R E Q U I R E M E N T S — 3 2 - B I T  W I N D O W S  VE R S I O N

• The following 32-bit Windows operating systems are supported:

- Windows 2000 with Service Pack 4 or later

- Windows XP with Service Pack 2 or later

- Windows 2003 Server with Service Pack 2 or later

- Windows Vista

• Pentium III or later

• OpenGL 1.1 from Microsoft or an accelerator that supports OpenGL 1.1, or 
DirectX version 8.0 or later. The graphics card should have at least 32 MB of 
memory.

S Y S T E M  R E Q U I R E M E N T S — 6 4 - B I T  W I N D O W S  VE R S I O N

• The following 64-bit Windows operating systems are supported:

- Windows XP Professional x64 Edition with Service Pack 2 or later

- Windows 2003 Server x64 Edition with Service Pack 2 or later

- Windows 2003 Server with Service Pack 2 or later

- Windows 2003 Compute Cluster Server with Service Pack 1or later

- Windows HPC Server 2008

- Windows Vista

• A PC with one of these processors: AMD with AMD64 or Intel with EM64T.

• A graphics card with at least 32 MB of memory

COMSOL Multiphysics System Requirements for Linux and Sun

S Y S T E M  R E Q U I R E M E N T S

Standalone COMSOL Multiphysics, the COMSOL Multiphysics client, and the 
COMSOL Multiphysics server are available in 32- and 64-bit versions as indicated in 
the table:

TABLE 1-1:  SYSTEM REQUIREMENTS FOR LINUX AND SUN PLATFORMS

PLATFORM OPERATING SYSTEM PROCESSOR

32-bit Linux Linux 2.4.x kernel, glibc-2.2.5 or later Pentium III or later

64-bit Linux Linux 2.4.x kernel, glibc-2.3.2 or later AMD with AMD64 or Intel 
with EM64T
S Y S T E M  R E Q U I R E M E N T S  |  5
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Note: On the Itanium 2 only the 64-bit COMSOL Multiphysics server is available. 
Here you must run the COMSOL Multiphysics client on a COMSOL Multiphysics 
platform other than Itanium using a floating network license to access the COMSOL 
Multiphysics server.

The following Linux distributions are officially supported by COMSOL:

In addition, see the graphics requirements in the following sections.

Linux Graphics Requirements
You can use any of the following XFree86 and graphics-driver configurations:

• XFree86 4.1 or later with XFree86’s Mesa library and DRI (Direct Rendering 
Infrastructure)

• XFree86 4.1 with NVIDIA driver 1.0-2880 or later

• XFree86 4.1 with ATI Fire GL2/3/4 drivers X4.1.0-1.9.16 or later. In order to get 
hardware acceleration with the Fire GL2/3/4 driver, set the environment variable 
LD_PRELOAD=/usr/lib/libGL.so before starting COMSOL (for example, 
LD_PRELOAD=/usr/lib/libGL.so comsol). According to ATI, this step is not 
necessary starting with the 1.9.19 driver.

• XFree86 4.1 with an official Mesa library (not XFree86’s library). You can obtain it 
at http://www.mesa3d.org/. Use this configuration if you cannot or do not want 
to use DRI.

• XFree86 3.3.6 with Mesa 3.1 or later

Sun Graphics Requirements
Frame Buffer with OpenGL support (XVR-500, XVR-1000, XVR1200, XVR-4000, 
Expert3D, Elite3D, Creator3D, or PGX).

Itanium Linux 2.4.x kernel, glibc-2.3.2 or later Itanium 2

Sun Solaris 8, 9, 10 UltraSPARC II or later

PLATFORM DISTRIBUTION

32-bit Linux Debian 3.0, 3.1, RedHat Enterprise 4/5, Fedora Core 8, SUSE 10.3

64-bit Linux SUSE 9.0, 9.3, and 10.3, RedHat Enterprise 4/5, Fedora Core 8

Itanium Debian 3.1 (IA-64), RedHat Enterprise 4 (Itanium)

TABLE 1-1:  SYSTEM REQUIREMENTS FOR LINUX AND SUN PLATFORMS

PLATFORM OPERATING SYSTEM PROCESSOR
1 :  I N S T A L L I N G  T H E  C O M S O L  S O F T W A R E



OpenGL 1.2.2 for Solaris or later. Depending on the type of frame buffer, a higher 
OpenGL version might be needed; for instance, XVR-1000 requires OpenGL 1.2.3.

COMSOL Multiphysics System Requirements for Mac

S Y S T E M  R E Q U I R E M E N T S — I N T E L  P R O C E S S O R ,  3 2  B I T

• Mac OS X 10.4.8, 10.5

• Java 1.5 or later (part of the Mac OS X installation)

S Y S T E M  R E Q U I R E M E N T S — I N T E L  P R O C E S S O R ,  6 4  B I T

• Mac OS X 10.5

• Java 1.5 or later (part of the Mac OS X installation)

S Y S T E M  R E Q U I R E M E N T S — PO W E R P C  P R O C E S S O R

• Mac OS X 10.3.1, 10.4, 10.5

• Java 1.4 or later (part of the Mac OS X installation)

• Java 3D and Java Advanced Imaging

• BSD Subsystem (part of the Mac OS X installation)

Optional MATLAB Add-On Requirements

The following chart indicates available MATLAB interfaces in COMSOL 3.5a.

a. Shared-memory parallelism is not supported for these interfaces.

TABLE 1-2:  MATLAB COMPATIBILITY CHART

PLATFORM 7.0 7.0.1 7.0.4 7.1 2006A/B 2007A/B

Windows, 32 bit  √  √  √  √  √  √

Windows, 64 bit  √  √

Linux, 32 bit  √a  √a  √a  √a  √a  √

Linux, 64 bit  √a  √a  √a  √a  √

Linux, Itanium

Sun, 32 bit  √  √  √  √  √

Sun, 64 bit  √b

Mac, Power PC  √  √  √  √  √  √

Mac, Intel, 32 bit  √ a

Mac, Intel, 64 bit  
S Y S T E M  R E Q U I R E M E N T S  |  7
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b. The CAD Import Module is not compatible with use of the interface to MATLAB 2007a/b on Sun.

CAD Import Modules Platform Support

Find the platform support for products in the CAD Import Module family in the 
following table:

a. Windows 2000 is not supported.
b. Only 32-bit Linux and 64-bit Linux are supported. The Itanium platform is not supported.
c. Only Solaris 10 is supported. On Sun, the CAD Import Module is not compatible with use of the interface 

to MATLAB 2007a/b (64 bit only).
d. Only 64 bit Macintosh is supported.

B I D I R E C T I O N A L  I N T E R F A C E  T O  S O L I D WO R K S

The Bidirectional Interface to SolidWorks has been tested with SolidWorks 2006 
SP5.1, SolidWorks 2007 SP5.0, and SolidWorks 2008 SP4.0. It is available on all 
platforms supported both by these versions and COMSOL Multiphysics. Supported 
on the Windows XP x64 platform are connections between SolidWorks 64 bit and 
COMSOL Multiphysics 64 bit, as well as between SolidWorks 32 bit and COMSOL 
Multiphysics 32 bit.

B I D I R E C T I O N A L  I N T E R F A C E  T O  A U T O D E S K  I N V E N T O R

The Bidirectional Interface to Autodesk Inventor requires Autodesk Inventor 2009. It 
is available on all platforms supported by Autodesk Inventor 2009.

TABLE 1-3:  CAD IMPORT MODULE SYSTEM REQUIREMENTS

PRODUCT REQUIRED PRODUCTS PLATFORM SUPPORT

CAD Import Module COMSOL Multiphysics Windowsa, Linuxb, Sunc, Macd

CATIA V4 Import Module CAD Import Module Windowsa, Linuxb, Sunc, Macd

CATIA V5 Import Module CAD Import Module Windowsa

Inventor Import Module CAD Import Module Windowsa

Pro/E Import Module CAD Import Module Windowsa, Linuxb, Sunc, Macd

VDA-FS Import Module CAD Import Module Windowsa, Linuxb, Sunc, Macd
1 :  I N S T A L L I N G  T H E  C O M S O L  S O F T W A R E



Parallel System Requirements

The table below shows the COMSOL 3.5a support for shared-memory parallelism and 
distributed-memory parallelism.

a. Requires Windows Compute Cluster Server 2003 with Service Pack 1 or later.
b. Requires glibc version 2.3.2 or higher.
c. Requires glibc version 2.3.4 or higher.

A D D I T I O N A L  L I N U X  D I S T R I B U T E D  M E M O R Y  S Y S T E M  R E Q U I R E M E N T S  

Supported operating systems: Red Hat Enterprise Linux 4 or 5 and SUSE Linux 9.0 
or 9.3. All computers in the cluster must use the same Linux version and should have 
similar hardware.

IPv6 Support

IPv4 is supported on all platforms. IPv6 is supported on all platforms except Itanium 
and Macintosh.

PLATFORM SHARED MEMORY DISTRIBUTED MEMORY

Windows, 32 bit  √    √a

Windows, 64 bit  √  √ a

Linux, 32 bit  √b   √b

Linux, 64 bit  √c  √c

Linux, Itanium  √  √

Sun, 32 bit  

Sun, 64 bit  √

Mac, Power PC

Mac, Intel, 32 bit  √

Mac, Intel, 64 bit  √
S Y S T E M  R E Q U I R E M E N T S  |  9
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I n s t a l l i n g  COMSOL on W indow s

Before You Begin

• Check that your system meets all applicable requirements (see “COMSOL 
Multiphysics System Requirements for Microsoft Windows” on page 4).

• Have your passcode or license file ready. A passcode has a form similar to:

FFFFFF-CUSV-123456-1234567-123456789

You need a passcode or a license file to install COMSOL 3.5a. You should have 
received it in an email or letter from your sales representative. If you have not received 
a passcode or a license file, contact your local COMSOL representative. 

Some COMSOL license types require that you also install a license manager before 
running a COMSOL software product. If you install COMSOL software with a 
passcode, no license manager is needed. If you install it with a license file, you need to 
install the license manager if the license file contains a line starting with the word 
SERVER. See “License Manager Installation” on page 26 for instructions. You can 
install your COMSOL software products and the license manager in any order.

Other COMSOL license types require a dongle (hardware lock). If you have received 
a dongle to use with the COMSOL software, please refer to dongle/readme.txt on 
the DVD for installation instructions.

An installation of earlier COMSOL versions on your computer is not affected by the 
COMSOL 3.5a installation except that double-clicking a Model MPH-file created 
with an earlier version of COMSOL will open it in COMSOL 3.5a. You can continue 
to use earlier versions or uninstall them independently of the COMSOL 3.5a 
installation.

Note: In this manual, the term COMSOL 3.5a refers not only to COMSOL 
Multiphysics 3.5a but also to any other members of the COMSOL product line.

Installing COMSOL 3.5a

1 Insert the COMSOL 3.5a DVD into the DVD drive. The COMSOL Setup window 
should appear automatically; if not, run the file setup.exe on the installation DVD. 
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Note that you might need to run setup_<language code>.exe for some 
languages that require special fonts.

When the installation components have been loaded, the COMSOL Setup window is 
replaced by the COMSOL 3.5a Installer window. To continue:

- Click New Installation and proceed to Step 2 to make a new installation.

- Click Add/Remove Features and proceed to Step 4 to change or repair an existing 
installation. For example, use Add/Remove Features when you add or remove 
documentation files for products installed or when you want to add or remove a 
product that your license includes.

- Click Change License and proceed to Step 2 to update license of an existing 
installation. Use this option when you have COMSOL 3.5a installed and get a 
new license file. The installer then removes features/products not licensed any 
more and lets you go through the Add/Remove Features procedure to add or 
remove features for the new license. If your trial license has expired you can use 
the Change License option to re-enable the old (paid) license.

- Click Uninstall COMSOL 3.5a to remove an existing installation.
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Note: You can change the path to the existing installation by pressing the F1 key.

2 Once you have read the license agreement, click the I accept the terms of the license 

agreement button and specify the license. You can use one of the following license 
formats:

- Passcode: Enter your passcode, which is a series of characters and numbers that 
has a form similar to FFFFFF-CUSV-123456-1234567-123456789. The passcode 
is case sensitive.

- License file: Enter the path to an existing license file or click Browse to select the 
file license.dat.

- Port number and Host name: Enter the host name of an existing license server and 
its license server port number.

- Three-server redundancy: Enter the host names and license server port numbers of 
an existing three-server redundant configuration.
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Note: If you clicked Change License in Step 1, you can choose to use an existing paid 
license or trial license, or you can choose to specify a new license. Click Next and 
proceed to Step 4 if you change the license to a license with different products. 
Otherwise, proceed to Step 9.

3 Click Next.

4 On the Platforms page, you can typically accept the default settings.

5 Click Next.

6 Select the features to install and specify the path to the COMSOL installation 
directory. Select MATLAB Interface and specify the MATLAB root folder if you want 
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the ability to run COMSOL using the MATLAB interface. MATLAB versions 7.0, 
7.0.1, 7.0.4, 7.1, 2006a/b, 2007a/b work with COMSOL 3.5a.

Feature symbols:

Note: If you clicked Add/Remove Features or Change License in Step 1, the Features 
page includes a Repair all selected features check box.

7 Click Next.

not currently installed, will be installed

not currently installed, will not be installed

currently installed, will not be updated

currently installed, will be updated

currently installed, will be removed
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8 Set the installation options. Here you can choose whether or not you want:

- COMSOL shortcuts on the Windows desktop

- COMSOL shortcuts on the Windows Start menu

- to associate the COMSOL Multiphysics model file type (.mph files) with the 
COMSOL installation. If you choose this option you can open COMSOL models 
by double-clicking them.

- to associate the COMSOL Reaction Engineering Lab model file type (.rxn files) 
with the COMSOL installation. If you choose this option you can open 
COMSOL Reaction Engineering Lab models by double-clicking them

9 Click Next.
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10 When you click Install the utility now installs or updates COMSOL. The installation 
process might take several minutes. The Finish page in Step 9 appears automatically 
when the installation process is finished.
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11 This window appears when the installation is finished. Click View Log to open a 
window that shows the installation log. Click Finish to quit the installer.

Automated Installation

You can install COMSOL using an automated installation process with minimal user 
interaction. An answer file then responds to questions while the installer is running. 
The answer file is a text file with a specific format that contains predefined settings that 
the COMSOL installer uses. Start the installation by running

 <path to DVD>\setup.exe -s <answer file path>

where <answer file path> is the path to your answer file. A template answer file, 
setup.ini, with detailed usage information is available on the DVD.

Removing (Uninstalling) the COMSOL Installation

To remove a COMSOL installation from your system, use the COMSOL uninstaller.
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Note: The uninstaller deletes all COMSOL 3.5a files and directories on the system 
that were installed by the COMSOL installer. Files and folders created after 
installation are not removed.

S T A R T I N G  T H E  U N I N S T A L L E R

To start the COMSOL uninstaller, use either of these methods:

• On the Windows Start menu point to Programs and then to COMSOL 3.5a. Click 
Uninstall COMSOL 3.5a.

• On the Windows Start menu, point to Settings, then click Control Panel. 
Double-click Add/Remove Programs. Select COMSOL 3.5a from the list.

R U N N I N G  T H E  U N I N S T A L L E R

Click Uninstall to start removing the installation. Click Finish to quit the installer when 
the deinstallation is complete.

Note: If you run COMSOL Multiphysics with MATLAB, close MATLAB before 
starting the uninstaller. If MATLAB is active, the utility cannot remove certain files.
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Automated Removal (Uninstallation) of COMSOL 3.5a

Similar to how you can automate the installation, you can also uninstall COMSOL 
using an answer file. The documentation on how to create such an answer file is in the 
template answer file, setup.ini, which is available on the DVD. When you have 
created an answer file for uninstalling, you start the uninstallation by running

 <path to DVD>\setup.exe -s <answer file path>

where <answer file path> is the path to your answer file.

Changing the Path to the MATLAB Installation

Edit the file comsol.opts in the bin directory under the COMSOL root directory 
(typically C:\COMSOL35a). In the file, change the line that starts with mlroot= to point 
to the root directory of your MATLAB installation.

Adding the Bidirectional Interface to SolidWorks to the CAD Import 
Module

If you have bought the CAD Import Module, the COMSOL Installer adds an add-in 
to SolidWorks called the COMSOL Multiphysics Interface. This add-in should appear on 
the SolidWorks user interface in the Add-Ins list that appears under the Tools menu.

The connection between COMSOL and SolidWorks can fail if SolidWorks is installed 
after COMSOL or if you make manual changes to the Windows registry. In the case 
of such a failure on Windows XP, it is possible to set up the connection as follows:

1 In SolidWorks, go to the File menu and choose Open.

2 In the Files of type list select Add-Ins (*.dll).

3 Load the file flswinterface.dll from the directory lib\win32 (Windows XP) 
or lib\win64 (Windows XP 64-bit) under the COMSOL 3.5a installation 
directory.

If your operative system is Windows Vista follow these steps instead:

1 Close SolidWorks if it is running on your computer.

2 Click the Start menu symbol in the lower-left corner of your Vista desktop.

3 Type cmd in the Start Search field.

4 cmd.exe appears in the list of programs. Right-click on it and select Run as 

administrator.
I N S T A L L I N G  C O M S O L  O N  W I N D O W S  |  19



20 |  C H A P T E R
5 In the command window that appears type one of the following, depending on your 
operative system

- on Vista 32-bit: regsvr32 C:\comsol35a\lib\win32\flswinterface.dll

- on Vista 64-bit: regsvr32 C:\comsol35a\lib\win64\flswinterface.dll

In the above C:\comsol35a is the local path to your COMSOL installation.

6 Open SolidWorks and on the Tools menu select Add-Ins.

7 In the Add-Ins dialog box that opens, make sure that the COMSOL Multiphysics 

Interface is active by checking the appropriate check boxes.

Adding the Bidirectional Interface to Autodesk Inventor to the CAD 
Import Module

If you have bought the CAD Import Module, the COMSOL installer adds an add-in 
to Autodesk Inventor called Simulation: COMSOL Multiphysics Interface. This 
add-in should appear in the Add-Ins list that appears under the Tools menu in the 
Autodesk Inventor user interface.

In case the connection between COMSOL and Autodesk Inventor fails, run the batch 
script RegisterInventorIface.bat located in the cad directory found under the 
COMSOL installation directory. In Windows XP, you do this by double-clicking the 
batch file’s icon in Windows Explorer; make sure that you have administrator privileges 
before running the script. On Windows Vista, instead right-click the icon and select 
Run as administrator.
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I n s t a l l i n g  COMSOL on L i n u x  and Sun

Before You Begin

Check that you have a license file license.dat, which you should have received by 
email. If you have not received a license file, contact your local COMSOL 
representative.

The license manager must be installed and started before running a COMSOL 
software product with the exception of trial licenses, which do not require a license 
manager. See “License Manager Installation” on page 26 for instructions. You can 
install your COMSOL software products and the license manager in any order.

The installation program is an X-Windows application and thus needs access to an 
X-Windows display to run. Make sure that your DISPLAY variable is set up correctly 
and that you have access to an X-Windows display. Try the command xclock to test 
that the X-Windows display is working properly. To install your COMSOL software 
products in a system directory such as /usr/local, you might need to run the 
installation program as the root user. The COMSOL installer for Linux and Sun does 
not modify any files on your system outside the COMSOL installation directory.

Installing COMSOL 3.5a

1 Insert the COMSOL 3.5a DVD into the DVD drive.

2 If the DVD is not mounted automatically by your operating system, use the mount 
command to mount it.

3 To start the installation, enter the command

sh drivepath/setup

where drivepath  is the mount point of the DVD drive, for example, 
/media/cdrom.

4 When the installer window appears, click New Installation.

5 Read the license agreement, select I accept the terms of the license agreement, specify 
License information, and then click Next.
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Note: If you have a Named Single User License and you are installing the software on 
the license server a dialog box will open up at this point and you will be asked to enter 
the user to bind the license to.

6 Select the platforms that you want to install and click Next.

7 Select the features to install and specify the path to the COMSOL installation 
directory. If you want the ability to run COMSOL using the MATLAB interface, 
select MATLAB Interface and specify the MATLAB root folder. MATLAB versions 
7.0, 7.0.1, 7.0.4, 7.1, 2006a/b, 2007a/b work with COMSOL 3.5a.

8 Click Next.

9 Click Install to start the installation.

10 When the installation process is finished the Finish window appears. If errors arose 
during installation, this window issues a notification. The installer also writes a log 
entry into the text file comsolsetup.log, which resides in the specified installation 
directory. Click Finish to quit the installer. Use the unmount and eject commands 
to unmount and eject the DVD. Some Linux and Sun configurations automatically 
unmount and eject the DVD when you press the DVD drive button.

The file browser in the doc directory attempts to start common web browsers. Edit 
the file in any text editor to adjust it for your preferred web browser. The variable 
BROWSERS in this file contains a list of web browsers in order of preference. The default 
list contains the following web browsers:

1 Mozilla

2 Firefox

3 Konqueror

4 Opera

5 Netscape

If you, for example, want to make Opera the preferred web browser, put it first in the 
list.
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Note: To make sure all users can easily start COMSOL, include the comsol35a/bin 
directory in all users’ paths or make a symbolic link from /usr/local/bin/comsol 
to the comsol command (see the ln command).

Removing (Uninstalling) the COMSOL Installation

The COMSOL 3.5a installation adds files only in the comsol35a directory. To remove 
the COMSOL installation, simply delete the comsol35a directory including all 
subdirectories.

Automated Installation

You can supply an answer file to the installer to run an unattended installation or to 
avoid the need of a display during the installation. The documentation on how to 
create an answer file is available in the template answer file, setup.ini, which you find 
on the DVD. When you have created an answer file, start the installation by running

 <path to DVD>/setup -s <answer file path>

where <answer file path> is the path to your answer file.

Changing the Path to the MATLAB Installation

Open the file comsol in the bin directory under the COMSOL installation directory. 
In the file, change the line that starts with mlroot= to point to the root directory of 
your MATLAB installation.
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I n s t a l l i n g  COMSOL on Ma c i n t o s h

Before You Begin

• Check that your system meets all applicable requirements (see “COMSOL 
Multiphysics System Requirements for Mac” on page 7).

• Have your passcode or license file ready. A passcode has a form similar to:

FFFFFF-CUSV-123456-1234567-123456789

New users can find the passcode or the license file in an email or letter from your sales 
representative. If you have not received a passcode or a license file, contact your local 
COMSOL representative.

Some COMSOL license types require that you also install a license manager before 
running a COMSOL software product. If you install COMSOL software with a 
passcode, no license manager is needed. If you install it with a license file, you need to 
install the license manager if the license file contains a line starting with the word 
SERVER. See “License Manager Installation” on page 26 for instructions. You can 
install your COMSOL software products and the license manager in any order.

If your Macintosh contains an old COMSOL (FEMLAB) installation, the 
COMSOL 3.5a installer does not remove it; it merely removes the MATLAB path to 
the old COMSOL version. You can keep the old version if desired as well as uninstall 
it before or after installing COMSOL 3.5a.

Installing Java 3D and Java Advanced Imaging

COMSOL requires Java 3D and Java Advanced Imaging from Apple. It is included in 
Mac OS X 10.4, but for Mac OS X 10.3 it must be installed separately. You can 
download this software update from

http://www.apple.com/downloads/macosx/apple/macosx_updates/
java3dandjavaadvancedimagingupdate.html

To install this software after the download:

1 If the disk image was not mounted automatically following the download, mount it 
by double-clicking the disk image file Java3D_and_JAI.dmg.

2 Double-click the file Java3D_and_JAI.mpkg to launch the installer. Follow the 
instructions to install the software update.
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Installing COMSOL 3.5a

Note: COMSOL does not work if the path to the COMSOL folder, or the name of 
the COMSOL folder itself, contain spaces.

1 Insert the COMSOL 3.5a DVD into the DVD drive. Launch the COMSOL Installer 
application from the Finder. The COMSOL 3.5a Installer window appears.

2 To proceed, see the instructions for Windows in the section “Installing COMSOL 
3.5a” on page 10. The procedure is the same for the Macintosh.

Removing (Uninstalling) the COMSOL Installation

The COMSOL 3.5a installation adds files only in the COMSOL35a folder. To remove 
the COMSOL installation, simply delete the COMSOL35a folder including all 
subfolders.

Automated Installation

You can install COMSOL using an automated installation process with minimal user 
interaction. The documentation on how to create an answer file is available in the 
template answer file, setup.ini, which you find on the DVD. When you have created 
an answer file, start the installation by running

 <path to DVD>/setup -s <answer file path>

where <answer file path> is the path to your answer file.

Changing the Path to the MATLAB Installation

Edit the file comsol in the bin directory under the COMSOL installation directory. 
In the file, change the line that starts with mlroot= to point to the root directory of 
your MATLAB installation.
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L i c e n s e  Manag e r  I n s t a l l a t i o n

The license manager supports a heterogeneous network of Windows, Linux, Sun, and 
Mac computers. Both the license manager and a COMSOL application can run on 
either Windows, Linux, Sun, or Mac platforms. We refer to the computer where the 
license manager is installed as the license server and any computers where the 
COMSOL applications are installed as clients. You can install COMSOL anywhere, 
typically on a local PC or on a file server where users access the program over a 
network. A single computer can function as a license server and a client, holding both 
the license manager and COMSOL. The COMSOL license manager does not require 
a MATLAB license manager.

To install a license manager, start by following the instructions in the section “Before 
You Begin” that follows immediately. Then, depending on the platform, go to the 
following sections:

You can install the license manager and COMSOL in any order. You cannot perform 
a full test of the installation until you have installed both.

COMSOL uses the FLEXnet™ license manager version 11 from Acresso Software Inc. 
for license management. (Note that FLEXnet was formerly called FLEXlm.)

Before You Begin

S Y S T E M  R E Q U I R E M E N T S

Before starting the installation process, check that your system meets all necessary 
requirements (see page 4). They are crucial for the COMSOL application, whereas the 
license manager only needs the correct hardware and operating system—for the license 
manager you need not consider memory and graphics requirements. The COMSOL 
license manager is completely independent of the MATLAB license manager.

LICENSE MANAGER INSTALLATION SECTIONS

“License Manager Installation on Windows” on page 28

“License Manager Installation on Linux and Sun” on page 30

“License Manager Installation on the Macintosh” on page 35
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O B T A I N I N G  A  F L E X N E T  L I C E N S E  F I L E

To install a COMSOL license manager you need a FLEXnet license file, license.dat. 
It looks something like this:

SERVER <my_server> 00b0d05d1635 1718
USE_SERVER
VENDOR LMCOMSOL
FEATURE SERIAL LMCOMSOL 3.5a permanent uncounted \
     VENDOR_STRING=T,7F3F3 HOSTID=DEMO SN=123456789 \
     SIGN=123456789ABC
INCREMENT COMSOL LMCOMSOL 3.5a permanent 10 DUP_GROUP=UH \
     SIGN=123456789ABC
INCREMENT COMSOLGUI LMCOMSOL 3.5a permanent 10 DUP_GROUP=UH \
     SIGN=123456789ABC
INCREMENT ChEM LMCOMSOL 3.5a permanent 5 DUP_GROUP=UH \
     SIGN=123456789ABC
INCREMENT EM LMCOMSOL 3.5a permanent 5 DUP_GROUP=UH \
     SIGN=123456789ABC
INCREMENT SME LMCOMSOL 3.5a permanent 5 DUP_GROUP=UH \
     SIGN=123456789ABC

As noted earlier, you should have received a COMSOL license.dat file with the 
COMSOL package. If you have not received it, contact your local COMSOL 
representative or send a request to support@comsol.com.

In the license.dat file, the text on the SERVER line should contain the license server 
name <my_server>, the hostid of the license server, and an optional port number.

Make sure that the license server name is the actual name of your license server; 
otherwise, change it by editing the file. You can also change the default port number 
(1718). This is necessary in the unlikely case that another program is already using that 
port number. If it becomes necessary to change the port number, any unused number 
between 1025 and 64,000 is valid.

Note: Only the license server name and the port number should change. Do not 
modify anything else in the license.dat file or your license will not work.

The VENDOR line defines the name of the vendor daemon binary, LMCOMSOL.

The SERIAL line contains license information.

The INCREMENT (can also be FEATURE) lines contain a product name, version, 
expiration date, and the number of available licenses. The example file just given shows 
that the user has a permanent COMSOL 3.5a license allowing ten concurrent users of 
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COMSOL Multiphysics and five concurrent users of the Chemical Engineering 
Module, the AC/DC Module, and the Structural Mechanics Module. The number 
after “SIGN=” at the end of each INCREMENT line contains a license key. To break up 
long lines use the continuation character (\).

In the event you have not received the license.dat file, you must provide us with 
the hostid of your license server (see “Obtaining a Hostid” on page 38 for 
instructions) and preferably your license server name. Please have them ready when 
contacting your local COMSOL representative.

License Manager Installation on Windows

You only need to install the license manager if you have obtained a license file that 
starts with a line that contains the word SERVER.

The license server requires these components:

• COMSOL license manager files (FLEXnet)

• License file (license.dat)

C O M S O L  L I C E N S E  M A N A G E R  F I L E S  ( F L E X N E T )

The license manager consists of four components:

• License manager daemon (lmgrd.exe)

• Vendor daemon (LMCOMSOL.exe)

• FLEXnet utility program (lmutil.exe)

• FLEXnet Control Panel (lmtools.exe)

The two daemons (lmgrd.exe and LMCOMSOL.exe) run on the license server. When a 
user starts COMSOL on a client computer, communication is established through the 
network from the client to the license server and the lmgrd.exe daemon. That 
daemon in turn makes a request to the vendor daemon (LMCOMSOL.exe), which 
releases licenses according to information in license.dat. The utility program and 
Control Panel handle license-server management. For more information on FLEXnet 
management, see Chapter 7 in the FLEXnet Licensing End Users Guide available 
from the COMSOL Help Desk.

I N S T A L L I N G  T H E  L I C E N S E  M A N A G E R  F I L E S

Install the license manager only on the host(s) listed in license.dat.
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If you want to install COMSOL on the same host as the license manager, first perform 
a complete COMSOL installation because that procedure installs the license manager 
files along with COMSOL. See the section “Installing COMSOL on Windows” on 
page 10 for installation instructions. When finished, skip the remainder of this section 
and continue with “Starting the License Manager” on page 29.

To install only the COMSOL license manager files, follow these instructions:

1 Insert the DVD into the DVD drive.

2 Follow the installation instructions starting on page 10 until you reach the Features 
screen in Step 4.

3 In the list of products to install, select only the License Manager check box.

4 Continue from the Features screen in the installation instructions to complete the 
license manager file installation.

Automated License Manager Installation
Alternatively, you can install the license manager using an automated installation 
process with minimal user interaction. See the section “Automated Installation” on 
page 17. Set licmanager = 1 in the answer file to install the license manager. 

S T A R T I N G  T H E  L I C E N S E  M A N A G E R

You can start the license manager manually, or it can run automatically as a service at 
boot.

Starting the Manager Automatically as a Service
To set up the license manager as a service from the FLEXnet Control Panel:

1 Locate the comsol35a\license\win32 (Windows) or 
comsol35a\license\win64 (64-bit Windows) directory and run lmtools.exe.

2 On the Service/License File page choose Configuration using Services. Note that you 
must perform this step every time you start the FLEXnet Control Panel.

3 Click the Configure Services tab.

4 Make an entry in the Service Name edit field, for example, COMSOL License 
Manager.

5 Specify the full path to lmgrd.exe, license.dat, and the debug log file of your 
choice.
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6 Select the Use Services check box (this might not be possible on all platforms, but it 
is recommended) and then the Start Server at Power Up check box.

7 Click Save Service. The license manager now starts at boot. If you prefer, start the 
license manager directly by choosing Start Server on the Start/Stop/Reread page.

Starting the Manager Manually
To start the license manager manually, change to the license\win32 (Windows) or 
license\win64 (64-bit Windows) directory. Now, in a command window enter

lmgrd -c ..\license.dat -l ..\comsol35a.log

The license manager is now ready to distribute licenses over the network. It writes 
debug information to the log file comsol35a\license\comsol35a.log.

S T A R T I N G  C O M S O L

After the installation is complete and the license manager daemons are running on the 
license server(s), you can start using COMSOL.

License Manager Installation on Linux and Sun

You do not need to install the license manager if you are installing a trial version. The 
full version, however, always requires a running license manager on Linux and Sun.

You need the following components on the license server:

• COMSOL License Manager files (FLEXnet)

• License file (license.dat).
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C O M S O L  L I C E N S E  M A N A G E R  F I L E S  ( F L E X N E T )

The license manager consists of three components:

• License manager daemon (lmgrd)

• Vendor daemon (LMCOMSOL)

• FLEXnet utility programs (lmutil and others)

The two daemons (lmgrd and LMCOMSOL) run on the license server. When a user starts 
COMSOL on a client computer, communication is established through the network 
from the client to the license server and the lmgrd daemon. The lmgrd daemon in turn 
makes a request to the vendor daemon (LMCOMSOL) to release a license. The vendor 
daemon releases licenses according to information contained in license.dat. The 
utility programs are used for license-server management. For more information on 
FLEXnet management, see Chapter 7 in the FLEXnet Licensing End Users Guide, 
which is available on the COMSOL 3.5a Help Desk.

I N S T A L L I N G  T H E  L I C E N S E  M A N A G E R  F I L E S

The license manager should be installed only on the host(s) listed in license.dat.

If you want to install COMSOL on the same host as the license manager, first perform 
a complete COMSOL installation because that procedure automatically installs the 
license manager files along with COMSOL (see the section “Installing COMSOL on 
Linux and Sun” on page 21). When finished, skip the remainder of this section and 
continue at “Starting the License Manager” on page 33.

If you want to install only the COMSOL license manager files, follow these 
instructions:

1 Insert the DVD into the DVD drive.

2 To start the installation, enter the following command:

/media/cdrom/setup

depending on where /media/cdrom is the mount point of the DVD drive.

3 Continue according to the installation instructions on page 25 until the step where 
you see the Features screen.

4 In the list of products to install, select only the License Manager check box.

5 Resume the installation instructions with the Features screen to complete the license 
manager file installation.
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Automated License Manager Installation
Alternatively, you can install the license manager using an automated installation 
process with minimal user interaction. See the section “Automated Installation” on 
page 23. Set licmanager = 1 in the answer file to install the license manager.

L I C E N S E  F I L E S  F O R  N A M E D  S I N G L E  U S E R  L I C E N S E

If you have a Named Single User License the installer automatically creates an options 
file that binds the license to the named user. This section describes the format of the 
options file and how the license.dat file points to the options file.

Below is an example of an options file, LMCOMSOL.opt, for a user “philip” who has 
access to COMSOL Multiphysics, the Structural Mechanics Module, and the CAD 
Import Module. Notice that to access COMSOL Multiphysics, the options file must 
include both the COMSOL and the COMSOLGUI features.

INCLUDE COMSOL USER philip
INCLUDE COMSOLGUI USER philip
INCLUDE CADIMPORT USER philip
INCLUDE SME USER philip

Each INCLUDE row in the LMCOMSOL.opt file has a corresponding FEATURE row in the 
license.dat file (with the USER_BASED keyword). The second item on each FEATURE 
row is the name of the feature for which you have a license.

The following table contains the feature names for all products in the COMSOL 3.5a 
product family:

TABLE 1-4:  COMSOL 3.5A PRODUCTS AND THEIR FEATURE NAMES

PRODUCT/FEATURE FEATURE NAME

COMSOL Multiphysics COMSOL

COMSOL Multiphysics GUI COMSOLGUI

COMSOL Multiphysics floating network license CLIENTSERVER

COMSOL Reaction Engineering Lab REACTION

AC/DC Module EM

Acoustics Module ACO

CAD Import Module CADIMPORT

Chemical Engineering Module ChEM

Earth Science Module ES

Heat Transfer Module HT

MEMS Module MEMS
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The license.dat file needs to point to the options file. The path to the options file is 
indicated by the “options” keyword. If your options file is placed here:

/usr/local/comsol35a/license/LMCOMSOL.opt

then the VENDOR row in license.dat should read

VENDOR LMCOMSOL options=/usr/local/comsol35a/license/LMCOMSOL.opt

S T A R T I N G  T H E  L I C E N S E  M A N A G E R

You can start the license manager manually or it can run automatically at boot.

Starting the License Manager Manually
To start the license manager manually, make the license/$arch directory the current 
directory and enter

./lmgrd -c ../license.dat -l /var/tmp/comsol35a.log

The server is now ready to distribute licenses over the network. It writes any debug 
information to the log file /var/tmp/comsol35a.log.

Starting the License Manager Automatically at Boot
Add Bourne shell commands to the appropriate boot script. You must be a superuser 
(root) to edit boot scripts.

Note: We do not recommended that you start the daemons as root for security 
reasons. Instead, use a dedicated username to start the license manager.

RF Module RF

Structural Mechanics Module SME

Optimization Lab OPTLAB

TABLE 1-4:  COMSOL 3.5A PRODUCTS AND THEIR FEATURE NAMES

PRODUCT/FEATURE FEATURE NAME
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The procedure for editing boot scripts on each platform appears in the following table:

TABLE 1-5:  BOOT SCRIPT PROCEDURES

PLATFORM PROCEDURE

Sun Copy the file comsol35a/license/sol2/rc.lm and paste it at the beginning 
of /etc/init.d/lmgrd. Create this file if it does not already exist.

Edit /etc/init.d/lmgrd, replacing ‘dir’ in the code fragment with the full 
path to the sol2 platform directory, and replace ‘username’ with an actual 
username.

If the file (link) /etc/rc3.d/S171lmgrd does not exist, create it with the 
commands

cd /etc/rc3.d
ln -s /etc/init.d/lmgrd S171lmgrd

SuSE Linux The following instructions should work for SuSE Linux distributions, where 
$arch is either glnx86 (32-bit Linux), or glnxa64 (64-bit Linux).

In the comsol35a/license/$arch directory, type the commands

cp rc.lm /etc/init.d/comsol35alm
chmod 755 /etc/init.d/comsol35alm

Edit /etc/init.d/comsol35alm, replacing dir with the full path to the 
$arch platform directory, and replace username with an actual username.

Now create the following link

cd /etc/init.d/rc5.d
ln -s ../comsol35alm S91comsol35alm

Debian 
Linux

The following instructions should work for Debian Linux distributions, where 
$arch is either glnx86 (32-bit Linux), or glnxa64 (64-bit Linux).

Copy the file comsol35a/license/$arch/lm_comsol to /etc/init.d

Edit /etc/init.d/lm_comsol. Update the FP and MYUSER variables as 
indicated in the file. Use the utility update-rc.d to automatically update the 
system's init script links:

update-rc.d lm_comsol start 99 2 3 4 5 . stop 1 0 1 6 .

This means that the COMSOL license manager is started by runlevels 2, 3, 4, 
and 5, and stopped by runlevels 0, 1, and 6. Type man update-rc.d for more 
information on init scripts. 

Linux The following instructions should work for most Linux distributions, where 
$arch is either glnx86 (32-bit Linux), glnxa64 (64-bit Linux), or glnxi64 
(Itanium).

Copy the file comsol35a/license/$arch/rc.lm and paste it at the end of 

/etc/rc.d/rc.local.

Replace ‘dir’ in the code fragment with the full path to the $arch platform 
directory, and replace ‘username’ with an actual username.
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S T A R T I N G  C O M S O L

After the installation is complete and the license manager daemons are running on the 
license server(s) you can start using COMSOL.

License Manager Installation on the Macintosh

You only need to install the license manager if you have obtained a license file that 
starts with a line that contains the word SERVER.

You need the following components on the license server:

• COMSOL License Manager files (FLEXnet)

• License file (license.dat)

C O M S O L  L I C E N S E  M A N A G E R  F I L E S  ( F L E X N E T )

The license manager consists of three components:

• License manager daemon (lmgrd)

• Vendor daemon (LMCOMSOL)

• FLEXnet utility programs (lmutil and others)

The two daemons (lmgrd and LMCOMSOL) run on the license server. When a user starts 
COMSOL on a client computer, communication is established through the network 
from the client to the license server and the lmgrd daemon. The lmgrd daemon in turn 
makes a request to the daemon (LMCOMSOL) to release a license. The vendor daemon 
releases licenses according to the information contained in license.dat. The utility 
programs are used for license-server management. For more information on FLEXnet 
management, see Chapter 7 in the FLEXnet Licensing End Users Guide, available as 
a part of the FLEXnet documentation and from the COMSOL Help Desk.

I N S T A L L I N G  T H E  L I C E N S E  M A N A G E R  F I L E S

You should install the license manager only on the host(s) listed in license.dat.

If you want to install COMSOL on the same host as the license manager, first perform 
a complete COMSOL installation because that procedure automatically installs the 
license manager files along with COMSOL (see the section “Installing COMSOL on 
Macintosh” on page 24). When finished, skip the remainder of this section and 
continue at “Starting the License Manager” on page 36.

If you want to install only the COMSOL license manager files, follow these 
instructions:
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1 Insert the COMSOL 3.5a DVD into the DVD drive.

2 Follow the installation instructions starting on page 25 until you reach the Features 
screen.

3 In the list of products to install, select only the License Manager check box.

4 Continue from the Features screen in the installation instructions (page 10) to 
complete the license manager file installation.

Automated License Manager Installation
Alternatively, you can install the license manager using an automated installation 
process with minimal user interaction. See the section “Automated Installation” on 
page 25. Set licmanager = 1 in the answer file to install the license manager.

S T A R T I N G  T H E  L I C E N S E  M A N A G E R

You can either start the license manager manually or let it run automatically at startup.

Starting the License Manager Manually
To start the license manager manually, perform these steps:

1 Launch the Terminal application.

2 Change directory to the license/macosx directory

cd /Applications/COMSOL35a/license/macosx

3 Then enter

./lmgrd -c ../license.dat -l /var/tmp/comsol35a.log

The server is now ready to distribute licenses over the network. It writes any debug 
information to the log file /var/tmp/comsol35a.log.

Starting the License Manager Automatically at Startup
A folder COMSOL_Lmgr located in the folder COMSOL35a/license/macosx holds a 
script that can automatically start the license manager when you start the computer. By 
installing and configuring this folder, there is no need to start the license manager 
manually.

1 Go to the top level /Library folder on your startup disk.

2 In the Library folder, create a folder StartupItems if it does not already exist.

3 Move or copy the folder COMSOL_Lmgr to the StartupItems folder.

4 Open the file COMSOL_Lmgr in a text editor, for example, TextEdit.

5 Edit the line
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FP=<COMSOLPATH>

by replacing <COMSOLPATH> with the path to the COMSOL folder. If COMSOL is 
installed in the Applications folder this path is

FP=/Applications/COMSOL35a

6 Edit the line 

USERNAME=<username>

by replacing <username> with your username.

To test the license manager installation restart the computer. During startup a message 
Starting COMSOL License Manager should appear.

S T A R T I N G  C O M S O L

After the installation is complete and the license manager daemons are running on the 
license server(s) you can start using COMSOL.

Changing the License

If you have received a new license file—for example, when adding COMSOL products 
to an existing license—replace your current license file with the new one. 
Double-check the contents of this file to make sure it lists the products that your 
license includes.

When you have changed the license file you must restart the license manager; 
otherwise, it will continue to use the old license file still in memory.

R E S T A R T I N G  T H E  L I C E N S E  M A N A G E R  O N  W I N D O W S

To restart the license manager on Windows, follow these steps:

1 In the Windows Start menu, choose COMSOL3.5a>License Tools>LMTOOLS.

2 In the FLEXnet Control Panel, click, in turn, Stop Server, ReRead License File, and 
Start Server.

R E S T A R T I N G  T H E  L I C E N S E  M A N A G E R  O N  L I N U X  A N D  S U N

To restart the license manager on Linux and Sun, make the license/$arch directory 
under the COMSOL installation directory the current directory, then enter the 
following commands

./lmdown -c ../license.dat

./lmgrd -c ../license.dat -l /var/tmp/comsol35a.log
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R E S T A R T I N G  T H E  L I C E N S E  M A N A G E R  O N  T H E  M A C I N T O S H

To restart the license manager on the Mac, do as follows:

1 Launch the Terminal application.

2 Change directory to the license/macosx directory

cd /Applications/COMSOL35a/license/macosx

3 Enter the commands

./lmdown -c ../license.dat

./lmgrd -c ../license.dat -l /var/tmp/comsol35a.log

Obtaining a Hostid

If COMSOL is already installed on your license server, you can determine the hostid 
by executing the lmhostid command

COMSOL35a/license/$arch/lmhostid

where $arch is either win32 (Windows), win64 (64-bit Windows), glnx86 (32-bit 
Linux), glnxa64 (64-bit Linux), glnxi64 (Itanium), sol2 (Sun), or macosx (Mac).

If COMSOL is not installed, you must obtain a hostid using OS commands as 
described in the following table:

FLEXnet uses different machine identifications for different architectures. For 
example, all Sun Microsystems machines have a unique hostid whereas other machines 
do not. For this reason, some machine architectures use an Ethernet address (also 

TABLE 1-6:  HOSTIDS FOR THE SUPPORTED PLATFORMS

PLATFORM HOSTID TYPE THIS COMMAND ON 
THE LICENSE SERVER:

EXAMPLE

Linux Ethernet 
address

/sbin/ifconfig 
eth0 and remove 
colons from HWaddr 
00:40:05:16:E5:25 
(do not use the hostid 
command)

00400516E525

Sun 32-bit hostid hostid 170a3472

Windows Ethernet 
address

ipconfig /all 
(remove hyphens from 
the physical address 
00-50-02-84-A3-28)

00500284A328

Mac Ethernet 
address

see below 00039377F4AC
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called a MAC address) as the hostid. An Ethernet address has six bytes, each with two 
hexadecimal digits. Be sure to specify all twelve hex digits when using an Ethernet 
address as a hostid. For example, if the Ethernet address is 8:0:20:0:5:ac specify 
0800200005ac as the hostid.

O B T A I N I N G  T H E  H O S T I D  O N  W I N D O W S

1 Open the Start menu and click Run.

2 Type cmd and click OK and the command window opens.

3 Type 

  ipconfig /all

and press Enter.

4 The FLEXnet hostid is equal to the Physical Address, which is displayed in the next 
image, with the hyphens removed.

O B T A I N I N G  T H E  H O S T I D  O N  A  M A C I N T O S H

1 Launch the application Network Utility found in the Applications/Utilities folder.

2 Click the Info tab to the left.

3 Select Network Interface (en0). This corresponds to your Ethernet card.

4 The hostid is the Hardware Address, which is displayed in the following image, with 
the colons removed. If you plan to install on a Macintosh laptop with a wireless 
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network card, please report the hardware address for both Network Interface (en0) 
and Network Interface (en1).
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T r oub l e s h oo t i n g  L i c e n s e  E r r o r s

This section summarizes the most common post-installation error messages generated 
by COMSOL, and it gives some advice how to troubleshoot them. Also check the 
COMSOL Support Knowledge Base at www.comsol.com/support/knowledgebase 
for up-to-date information about installation and license issues

TABLE 1-7:  GENERAL ERROR MESSAGES

ERROR MESSAGE EXPLANATION

License error A general license error has occurred. Check the error message for 
details that might help solve the problem. If you need help in 
interpreting the information, send the complete error message to 
support@comsol.com.

License error: -5. 
No such feature 
exists.

The license manager has encountered a problem during startup. 
Check the license manager log file for error messages. The log file 
is usually placed here:

Windows: C:\COMSOL35a\license\comsol35a.log

Linux/Sun/Mac: /var/tmp/comsol35a.log

Please send the log file to support@comsol.com if you want help 
in interpreting the information.

NOTE: The license manager creates the log file. If there is no log 
file, make sure to first start the license manager. Please refer to the 
section “License Manager Installation” on page 26 for instructions 
how to install and start the COMSOL license manager. 

License error: -12. 
Invalid returned 
data from license 
server system.

Check that no firewall on the COMSOL client is preventing the 
connection from the COMSOL client to the license server. 
Temporarily disable any firewall on the COMSOL client to see if 
that helps.

Check that no firewall on the license server is preventing the 
connection from the COMSOL client computer to the license 
manager, or the connection from the lmgrd daemon and the 
LMCOMSOL daemon.

If the problems remain, send the license manager log file to 
support@comsol.com. The log file is usually placed here:

Windows: C:\COMSOL35a\license\comsol35a.log

Linux/Sun/Mac: /var/tmp/comsol35a.log
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License error: -15. 
Cannot connect 
to license server 
system.

The COMSOL license manager has not been installed or started 
yet. If the first line of your license.dat file looks like this:

   SERVER mylicserver 000123456789 1716

a license manager is required. Please refer to the section “License 
Manager Installation” on page 26 for instructions how to install and 
start the COMSOL license manager.

Check that no firewall on the COMSOL client is preventing the 
connection from the COMSOL client to the license server. 
Temporarily disable any firewall on the COMSOL client to see if 
that helps.

Check that no firewall on the license server is preventing the 
connection from the COMSOL client computer to the license 
manager.

Check that the license.dat file on the COMSOL client 
computer points to the correct license server hostname. First, find 
the license.dat file in the COMSOL application folder:

Windows: C:\COMSOL35a\license\license.dat

Linux/Sun: /usr/local/comsol35a/license/license.dat

Mac: /Applications/comsol35a/license/license.dat

Check that the first line has the correct license-server hostname. 
For example, if your license server hostname is mylicserver, the 
first row in the license.dat file should look like this:

   SERVER mylicserver 000123456789 1716

If the COMSOL client computer does not recognize 
mylicserver as a proper hostname, it might help to instead use 
the fully qualified domain name (mylicserver.mydomain.org) 
or the IP address. If neither of these work, there might be a 
problem with DNS or the HOSTS file on the client. Please ask 
your system administrator for advice on how to connect with 
TCP/IP to the license server.

Finally, the license manager might have encountered a problem 
during startup. Check the license manager log file for error 
messages. The log file is usually placed here:

Windows: C:\COMSOL35a\license\comsol35a.log

Linux/Sun/Mac: /var/tmp/comsol35a.log

NOTE: The log file is created by the license manager after it has 
been started.

Please send the log file to support@comsol.com if you want help 
in interpreting the information.

TABLE 1-7:  GENERAL ERROR MESSAGES

ERROR MESSAGE EXPLANATION
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License error: -39. 
User/host not on 
INCLUDE list for 
feature.

This error can only occur for the Named Single User License 
(NSL) license type. The error means that your username does not 
match the one listed in the license-manager options file, 
LMCOMSOL.opt. To get access to COMSOL, ask your license/
system administrator for help. When the username in the options 
file is changed, the license manager must be shut down and 
restarted to give the new user immediate access to COMSOL. 

License error: -88. 
System clock has 
been set back.

The software has detected that a system clock has been set back.

Please make sure that your computer’s clock is set to the current 
local time and date. If the problem remains check that there are no 
files on your hard drive that are dated in the future.

License error: -96. 
License server 
machine is down 
or not responding.

Please make sure that the SERVER hostname in the license.dat 
file is valid and that the TCP/IP network connection between the 
application computer and the license server is working properly.

The license.dat file is located in the COMSOL application 
folder:

Windows: C:\COMSOL35a\license\license.dat

Linux/Sun: /usr/local/comsol35a/license/license.dat

Mac: /Applications/comsol35a/license/license.dat

License error: -97. 
The desired 
vendor daemon is 
down.

The license manager has encountered a problem during startup. 
Check the license manager log file for error messages. The log file 
is usually placed here:

Windows: C:\COMSOL35a\license\comsol35a.log

Linux/Sun/Mac: /var/tmp/comsol35a.log

NOTE: The log file is created by the license manager after it has 
been started. 

Please send the log file to support@comsol.com if you want help 
in interpreting the information. 

TABLE 1-7:  GENERAL ERROR MESSAGES

ERROR MESSAGE EXPLANATION
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Upda t i n g  COMSOL

To make sure your COMSOL installation is up to date, you can check for product 
updates by choosing Check For Updates from the Help menu. If any update is available, 
the application will direct you to a website where you can download the update. 
Download the update and place it in the updates/ folder of your COMSOL 
installation. To install the update on a Windows machine, select 
Programs>COMSOL 3.5a>Tools>Install COMSOL Update from the Windows Start menu. 
To install the update on other platforms, run comsol update.
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R u n n i n g  C O M S O L
This chapter describes the various options for running the COMSOL software 
products on the supported platforms.
 45
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The installer adds the folder COMSOL 3.5a to the Start menu under the Programs item. 
That folder contains a selection of the items in the following list depending on the 
licensed COMSOL software products you have:

• COMSOL Multiphysics: Opens COMSOL Multiphysics. A corresponding shortcut is 
added to the desktop.

• COMSOL with MATLAB: Starts MATLAB 7.0, 7.0.1, 7.0.4, 7.1, 2006a/b, or 2007a/
b and sets up all necessary paths, and then it opens the COMSOL Multiphysics 
graphical user interface. If you quit COMSOL Multiphysics you can launch it again 
by typing comsol at the MATLAB command prompt. A corresponding shortcut is 
added to the desktop.

• COMSOL Multiphysics Client: Starts a COMSOL Multiphysics client for connecting to 
a COMSOL Multiphysics server (see the section “Running COMSOL Multiphysics 
Client/Server” on page 62).

• COMSOL Multiphysics Server: Starts a COMSOL Multiphysics server that a COMSOL 
Multiphysics client can connect to (see the section “Running COMSOL 
Multiphysics Client/Server” on page 62).

• Uninstall COMSOL 3.5a.

• Documentation: A folder that contains COMSOL documentation shortcuts.

Running COMSOL Multiphysics

You can run COMSOL Multiphysics by double-clicking the COMSOL Multiphysics 3.5a 
icon on the desktop.

Alternatively, to activate COMSOL Multiphysics from the Start menu, point to 
Programs, then to COMSOL 3.5a, and then click COMSOL Multiphysics.
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Running COMSOL Multiphysics with MATLAB

To run COMSOL Multiphysics with MATLAB, double-click the COMSOL 3.5a with 

MATLAB icon on the desktop.

Alternatively, start COMSOL Multiphysics with MATLAB from the Start menu by 
pointing to Programs, then to COMSOL 3.5a, and then select COMSOL with MATLAB.

T H E  C L A S S P A T H  F I L E  A N D  I T S  L O C A T I O N

The classpath.txt file specifies which Java class path to use inside MATLAB. When 
starting COMSOL Multiphysics with MATLAB, COMSOL Multiphysics copies 
classpath.txt from the toolbox\local directory under the MATLAB installation 
to the directory specified as the Start in directory for the COMSOL with MATLAB shortcut. 
It then writes some extra lines to this file to include the Java class paths that COMSOL 
Multiphysics needs. Therefore you must have write access to the Start in directory 
when starting MATLAB using the comsol command. COMSOL also creates a 
java.opts file in your current directory. To change the Start in directory:

1 Right-click the COMSOL with MATLAB shortcut and choose Properties.

2 On the Shortcut page, type the path to the starting directory in the Start in edit field.

3 Click OK.
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Running COMSOL Multiphysics

Run the comsol command. If it is not available, ask your system manager to make it 
available to you.

Running COMSOL Multiphysics with MATLAB

Run the command

comsol matlab

to launch MATLAB with paths setup to run COMSOL Multiphysics functions.

Run the command

comsol matlab multiphysics

to launch the COMSOL Multiphysics user interface from within the MATLAB 
environment.

The script comsol creates the files classpath.txt and java.opts that MATLAB 
requires, and it puts those files in the current directory. Therefore you must have write 
access to this directory when starting MATLAB using the comsol command.

Note: To be able to run 64-bit COMSOL on Linux/Sun, make sure that you have 
installed the 64-bit support for your platform. COMSOL 32-bit with MATLAB on 
64-bit Linux is not supported.

Considerations on Linux

COMSOL has been compiled to run on certain older versions of Linux. COMSOL 
does not automatically detect these older Linux versions, so you need to tell COMSOL 
about this. These versions do not have full parallel support.
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3 2 - B I T  L I N U X

To run COMSOL on a Linux version with glibc version lower than 2.3.2, you need to 
run the comsol command with the -gcc323 option. Type comsol -gcc323 to start 
COMSOL.

6 4 - B I T  L I N U X

To run COMSOL on a Linux version with glibc version lower than 2.3.4, you need to 
run the comsol command with the -gcc332 option. Type comsol -gcc332 to start 
COMSOL.
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The COMSOL Applications

The following five applications allow you to run COMSOL as described in the 
following sections.

Note: None of the COMSOL applications work if you move them outside the 
COMSOL folder. Create an alias if, for example, you want a desktop icon.

• COMSOL Multiphysics application

This is the primary application to run the software. It launches COMSOL 
Multiphysics as a standalone application.

• COMSOL with MATLAB application

Use this application when you want to use the interface between COMSOL 
Multiphysics and MATLAB. This application first launches MATLAB and then the 
COMSOL Multiphysics graphical user interface. If you quit COMSOL 
Multiphysics you can launch it again by typing comsol at the MATLAB command 
prompt.

Note: The COMSOL with MATLAB application requires that you use Apple’s X11 
application together with MATLAB. The X-Windows application OroborOSX is not 
supported.

• COMSOL Multiphysics Client application

This application launches a COMSOL Multiphysics client that connects to a 
COMSOL Multiphysics server (see the section “Running COMSOL Multiphysics 
Client/Server” on page 62).

• COMSOL Multiphysics Server application

This application launches the Terminal application and starts a COMSOL 
Multiphysics server in a terminal window (see “Running COMSOL Multiphysics 
Client/Server” on page 62).
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Running COMSOL Multiphysics from a Terminal Window

You can also launch COMSOL Multiphysics from a terminal window using the shell 
script COMSOL35a/bin/comsol. See the section “Running COMSOL on Linux/Sun” 
on page 48 for options available in the comsol command.

To run the comsol command more easily, include the COMSOL35a/bin directory in the 
path or make a symbolic link from /usr/bin/comsol to the comsol script. Those with 
administrator privileges can create a symbolic link with the command

sudo ln -s /Applications/COMSOL35a/bin/comsol /usr/bin/comsol

(assuming COMSOL is installed in the Applications folder). This command asks for 
a password before creating the link.

Note: The comsol command must not be moved from the COMSOL35a/bin folder. 
The COMSOL applications also use this script.
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Use the comsol command to start COMSOL products with detailed start-up options. 
This command works similarly on all platforms, but there are differences in availability 
and options. On non-Windows platforms, you can start all COMSOL products with 
the comsol command. On Windows there are some differences: you must use different 
commands to start 32- and 64-bit applications, and you need special commands to 
start terminal-based products (see availability in the following chart).

The general syntax of the comsol command is

comsol [<options>] [<target>] [<target arguments>] [<expression>]

where square brackets indicate optional arguments. Table 2-1 lists available options.

TABLE 2-1:  COMSOL OPTIONS (CURLY BRACKETS INDICATE DEFAULT VALUES)

COMSOL OPTION DESCRIPTION AVAILABILITY

-32 Use a 32-bit data model 
if available

In Windows, use 
comsol.exe

-64 Use a 64-bit data model 
if available

In Windows, use 
comsol64.exe. Not 
available on PowerPC 
Mac

-blas {auto} | mkl | 
atlas | sunperf | path | 
acml | veclib

BLAS library to use See section “COMSOL 
and BLAS” on page 70

-h Print general help

-h <target> Print target-specific help

-ipv6 Activate IPv6 support

-mesa Use mesa software 
rendering libraries

Only available on Linux

-mpmode <throughput> | 
<turnaround> | <owner>

Multiprocessor mode See “Optimizing 
Processor Usage” on 
page 68

-nn <no. of nodes> Number of nodes Available on Linux and 
Windows CCS 2003

-nopin Disable process pinning 
on cluster

Available on Linux

-np <no. of processors> Number of processors Not available on 
PowerPC Mac
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We support the 64-bit option on Linux, Itanium, Intel Mac, and Sun platforms. On 
Windows, use the comsol.exe and comsol64.exe commands to start 32- and 64-bit 
products, respectively. For the -tmpdir option, COMSOL software uses the specified 
directory to store temporary files. The -prefsdir option specifies the directory where 
COMSOL should store the preference file.

The available comsol command targets are:

-prefsdir <path> Preference directory

-tmpdir <path> Temporary file directory

-version Print COMSOL version

-version <target> Print target version

TABLE 2-2:  COMSOL COMMAND TARGETS

TARGET DESCRIPTION AVAILABILITY

multiphysics Run standalone 
COMSOL Multiphysics

batch Run COMSOL 
Multiphysics in batch 
mode

In Windows, use 
comsolbatch.exe or 
comsolbatch64.exe

client Run COMSOL 
Multiphysics client

matlab Run COMSOL 
Multiphysics with 
MATLAB

mpd Run a COMSOL MPD 
(multiprocessor 
daemon) command

Only available on Linux

reaction Run COMSOL Reaction 
Engineering Lab

In Windows, optionally use 
comsolreaction.exe or 
comsolreaction64.exe

server Run COMSOL 
Multiphysics server

This is the only target 
available on the Itanium 
platform. In Windows use 
comsolserver.exe or 
comsolserver64.exe

update Install COMSOL update

TABLE 2-1:  COMSOL OPTIONS (CURLY BRACKETS INDICATE DEFAULT VALUES)

COMSOL OPTION DESCRIPTION AVAILABILITY
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From within COMSOL Multiphysics and COMSOL Reaction Engineering Lab, you 
can start the other product by clicking its name in the File menu. This means the 
products run within the same process and that they can intercommunicate. Never start 
products separately if you want to make them communicate later on. From within 
MATLAB you can start the COMSOL Multiphysics graphical user interface and the 
COMSOL Multiphysics server by using the M-file comsol.m. For more information 
about the COMSOL Multiphysics client/server architecture, see the section 
“Running COMSOL Multiphysics Client/Server” on page 62.

G E N E R A L  C O M S O L  T A R G E T  C O M M A N D - L I N E  A R G U M E N T S

Example
Start COMSOL Server and COMSOL Client, explicitly choosing a port number, 
enabling repeated client connections, and indicating that you want to provide a new 
passcode to the COMSOL Server.

comsol server -login force -port 4711 -multi on
comsol client -port 4711

C O M S O L  B A T C H  A R G U M E N T S

The general syntax for the command for starting COMSOL Batch is

comsol [<options>] batch [<target arguments>]

TABLE 2-3:  COMSOL TARGET COMMAND-LINE ARGUMENTS

TARGET OPTION DESCRIPTION

multiphysics | 
reaction

-open Open model file

server | client -port Server port number

server | client -timeout Time before disconnecting 
in seconds

server -multi on | {off} Accept repeated client 
connections

server -login {info} | force | never Show login dialog box
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The COMSOL Batch mode can be used to run parametric sweeps (see “Setting Up 
Parametric Sweeps” on page 383 of the COMSOL Multiphysics User’s Guide for a 
description of this feature). Its detailed command arguments are:

Example
An example of using the comsol batch command on Linux is

comsol batch -input <file name>

On Windows, run the following command:

comsolbatch.exe -input <file name>

This command starts COMSOL Batch, solves the model in the Model MPH-file with 
the given file name using the active solver settings in the model, and stores the solution 
in the same file.

M AT L A B  A R G U M E N T S

The command comsol matlab [<options>] starts MATLAB with the COMSOL 
paths set up. Run the command comsol matlab multiphysics to also launch the 
COMSOL Multiphysics user interface.

Similarly, comsol matlab path [<options>] starts MATLAB with the COMSOL 
path set up. 

The command comsol matlab server [<options>] starts MATLAB with the 
COMSOL path set up and starts a COMSOL Multiphysics server.

TABLE 2-4:  COMSOL BATCH-SPECIFIC ARGUMENTS

COMSOL BATCH ARGUMENTS DESCRIPTION

-input <file name> Load the Model MPH-file with the given file 
name and solve using current solver 
settings. Note that the model must be 
meshed.

-output <file name> Save the Model MPH-file using the given file 
name. If output is not given, the input file 
will be overwritten with the output.

-paramfile <file name> File with parameter values.

-logfile <file name> File to stored evaluated expressions in.

-pname <comma-separated list> Parameter names.

-globals <comma-separated list> Global expressions to evaluate.

-psave on | {off} Store intermediate solutions on file.
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The command comsol matlab reaction [<options>] starts MATLAB and the 
COMSOL Reaction Engineering Lab graphical user interface.

The full list of options for comsol matlab are:

Examples:
Start MATLAB without the MATLAB desktop and without the MATLAB splash 
screen and run mycomsolscript.

comsol matlab path -ml -nodesktop -ml -nosplash -mlr mycomsolscript

Note: On Windows MATLAB uses DOS-type input arguments, so the equivalent line 
is 
comsol matlab path -ml /nodesktop -ml /nosplash -mlr mycomsolscript

Run COMSOL Multiphysics with MATLAB using MATLAB installed in /usr/
local/MyMatlab.

comsol matlab multiphysics -mlroot /usr/local/MyMatlab

TABLE 2-5:  COMSOL MATLAB-SPECIFIC ARGUMENTS

MATLAB ARGUMENTS DESCRIPTION

{path} Set up COMSOL path 
within MATLAB

multiphysics Run COMSOL 
Multiphysics within 
MATLAB

server Run COMSOL server 
within MATLAB

-ml <option> Start MATLAB using the 
specified option

-mlr <expression> Evaluate expression in 
MATLAB after 
COMSOL within 
MATLAB has started

-mlroot <directory> Specify root directory 
for MATLAB installation

-D<debugger> Run MATLAB in 
debugger, no COMSOL 
paths set
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PE R M A N E N T L Y  C H A N G I N G  T H E  M AT L A B  O P T I O N S

You can add the MATLAB startup options to the file comsol.opts (on Windows) or 
comsol (on the Linux, Sun, and Macintosh platforms). On the line that starts with the 
string mlargs=, add the MATLAB startup options that you want to use. For example,

mlargs=-nodesktop -nosplash

starts COMSOL Multiphysics with MATLAB without showing the MATLAB splash 
screen and providing MATLAB without the desktop environment.
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S e r v e r  A r c h i t e c t u r e

Standalone COMSOL Multiphysics

The most straightforward way of running COMSOL Multiphysics is as a standalone 
application. Standalone COMSOL Multiphysics 3.5a can run as a 32-bit application 
on Windows, Linux, Sun, and Mac.

In addition, COMSOL Multiphysics can run in 64-bit mode as a standalone 
application on 64-bit Windows plus 64-bit Linux, Intel Mac and Sun.

Running COMSOL Multiphysics with MATLAB

COMSOL Multiphysics can run together with MATLAB on the same machine using 
COMSOL Multiphysics’ client/server architecture. The COMSOL Multiphysics 
server runs on the Java engine within MATLAB, while the COMSOL Multiphysics 
graphical user interface runs as a separate application. COMSOL Multiphysics starts 

Computer

Process (32- or 64-bit)

COMSOL Multiphysics
(GUI and solvers)
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automatically in this configuration when you run COMSOL Multiphysics with 
MATLAB.

MATLAB can currently run in 32-bit mode on Windows, Linux, Sun, and Mac, which 
means that COMSOL Multiphysics with MATLAB also runs in 32-bit mode within 
MATLAB on those platforms. In addition, COMSOL Multiphysics with MATLAB 
can run in 64-bit mode on 64-bit Windows with MATLAB 2006a/b and 2007a/b; 
on 64-bit Linux with MATLAB 7.0.1, 7.0.4, 7.1, 2006a/b, and 2007a/b; and on Sun 
with MATLAB 2007a/b.

Running COMSOL Multiphysics as a Client/Server Application

The COMSOL Multiphysics client runs as a 32-bit application on all platforms for 
which we distribute the software: Windows, Linux, Sun, and the Mac. In addition, the 
COMSOL Multiphysics client can run as a 64-bit application on 64-bit Windows plus 
64-bit Linux, Intel Mac, and Sun.

T H E  C O M S O L  M U L T I P H Y S I C S  S E R V E R

The COMSOL Multiphysics server can run as a 32-bit application on Windows, Linux, 
Sun, and Mac. The COMSOL server is available as a 64-bit application on 64-bit 
Windows, 64-bit Linux, Itanium, Intel Mac and Sun.

Computer

Process (32- or 64-bit)

COMSOL Multiphysics

A COMSOL Multiphysics

Process (32- or 64-bit)

Running a

MATLAB

client COMSOL Multiphysics
server from Java
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R U N N I N G  C O M S O L  M U L T I P H Y S I C S  C L I E N T / S E R V E R  O N  T H E  S A M E  

C O M P U T E R

Both the COMSOL Multiphysics client and the COMSOL Multiphysics server can 
run on the same computer and with all available license types: named user license 
(NSL), CPU locked license (CPU), and floating network license (FNL). 

R U N N I N G  C O M S O L  M U L T I P H Y S I C S  C L I E N T / S E R V E R  O N  D I F F E R E N T  

C O M P U T E R S

The COMSOL Multiphysics client and COMSOL Multiphysics server can also run on 
different computers, but this configuration requires a floating network license (FNL).

This is the only way to run the COMSOL Multiphysics server on the Itanium platform 
because neither the COMSOL Multiphysics client nor standalone COMSOL 
Multiphysics are available for this platform.

R U N N I N G  C O M S O L  M U L T I P H Y S I C S  C L I E N T  A N D  C O M S O L  M U L T I P H Y S I C S  

S E R V E R  I N  M AT L A B

It is also possible to run the COMSOL Multiphysics server in MATLAB without 
starting the COMSOL Multiphysics graphical user interface. In this configuration you 
can access a COMSOL Multiphysics server running within MATLAB on a remote 

Single computer

Process (32- or 64-bit)

Client (GUI) Server (Solvers)

Process (32- or 64-bit)

Computer

Process (32- or 64-bit)

Client (GUI)

Computer

Process (32- or 64-bit)

Server (Solvers)
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computer. This configuration also requires a floating network license (FNL) for 
COMSOL Multiphysics.

Computer

Process (32- or 64-bit)

Client (GUI)

Computer

Process (32- or 64-bit)

MATLAB running
Server (Solvers)
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C l i e n t / S e r v e r

The COMSOL Multiphysics graphical user interface can run in a separate process as a 
client to a COMSOL Multiphysics server. The COMSOL Multiphysics client uses a 
TCP/IP connection to connect to the COMSOL Multiphysics server. The client and 
server need not run on the same platform. You must have a floating network license 
(FNL) to run the COMSOL Multiphysics server and the COMSOL Multiphysics 
client on separate computers.

You can also use the COMSOL Multiphysics client/server when running COMSOL 
Multiphysics with MATLAB. To do so, start a COMSOL Multiphysics client on a 
separate computer and connect to a COMSOL Multiphysics server started from within 
a MATLAB process.

Advantages of Using COMSOL Multiphysics Client/Server

The COMSOL Multiphysics client/server configuration frees your desktop computer 
of lengthy computations, dispatching your jobs to a dedicated computer. The 
computer that runs the COMSOL Multiphysics server could have more memory and 
a faster CPU than your desktop computer.

Note, too, that running the COMSOL Multiphysics server and the COMSOL 
Multiphysics client separately on the same computer increases the total memory 
available to solve problems. This is particularly interesting because the 32-bit limit on 
addressable memory can be the limiting factor for complex models. The COMSOL 
Multiphysics server components do not use the memory required for the graphical user 
interface, freeing that memory for the actual computations on the server.

Running COMSOL Multiphysics Client/Server

S T A R T I N G  C O M S O L  M U L T I P H Y S I C S  S E R V E R

When you have access to the Windows desktop, start the COMSOL Multiphysics 
server from the Start menu. Go to Programs, select COMSOL 3.5a, and then Client/Server. 
If starting the COMSOL Multiphysics server from a terminal window in Windows, use 
the command C:\COMSOL35a\bin\comsolserver.exe. 
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On Linux and Sun, use the comsol server command to start a COMSOL 
Multiphysics server.

On the Mac, use the COMSOL Multiphysics Server application, or if you are logging on 
to the Mac from another computer, use the comsol server command in the terminal 
window.

S T A R T I N G  A  C O M S O L  M U L T I P H Y S I C S  C L I E N T

To start a COMSOL Multiphysics client under Windows, use the Start menu. Go to 
Programs, select COMSOL 3.5a, and then Client/Server. To start a client on Linux and Sun 
use the comsol client command. On Mac OS X use the COMSOL Multiphysics Client 
application.

A C C E S S I N G  T H E  C O M S O L  M U L T I P H Y S I C S  S E R V E R  C O M P U T E R

To access the COMSOL Multiphysics server computer under Linux, Sun, or Mac OS 
X, simply log in on the server computer by using ssh, rlogin, or telnet, then enter 
the comsol server command. When running the COMSOL Multiphysics server 
within MATLAB on Linux and Sun, you need access to the X-Windows display 
pointed to by the DISPLAY variable. On Mac OS X, you need access to the Mac 
desktop, that is, you must be logged on from the Mac OS X computer console in order 
to run the COMSOL Multiphysics server within MATLAB.

On Windows you can access the server computer in several ways. If it is dedicated to a 
single person, you can sit down at that machine and log in on it. You can also connect 
to the server computer by using NetMeeting or Remote Desktop (Windows XP). Start 
the COMSOL Multiphysics server from the Start menu. If several people want to 
access a single Windows computer to run the COMSOL Multiphysics server, you must 
use Windows Terminal Server or another tool that allows multiple users to log in on 
the same Windows server. In some Windows versions, Microsoft provides a Telnet 
Server with which you can log in through a terminal window. When using a terminal 
window to log in on Windows, use the comsolserver command to start the 
COMSOL Multiphysics server.

I N I T I A L I Z I N G  T H E  C O M S O L  M U L T I P H Y S I C S  S E R V E R

The first time you start a COMSOL Multiphysics server on a computer, a dialog box 
asks for a user name and password. A terminal window without access to a display does 
not allow you to open this dialog box, so you cannot use a terminal window when 
initially logging on to the server computer. The easiest method is to sit down at the 
computer and log in on it the first time you start the COMSOL Multiphysics server. 
Enter a user name and password, and then select the Remember password check box. 
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You can now connect through a terminal window the next time you want to run the 
COMSOL Multiphysics server.

PO R T  N U M B E R

The COMSOL Multiphysics server requires that each user log in and start the 
COMSOL Multiphysics server manually. The COMSOL Multiphysics server prints a 
port number in the terminal window. In the COMSOL Multiphysics client, go to the 
Model Navigator, click the Settings tab, and provide the computer name and a port 
number. If you have identical home directories on the server and client and you start 
the COMSOL Multiphysics client after the COMSOL Multiphysics server has been 
started, the COMSOL Multiphysics client can obtain the computer name and port 
number from the .comsol directory in your home directory. If the COMSOL 
Multiphysics client has not determined the computer name and port number, you 
must enter them manually.

D I S C O N N E C T / R E C O N N E C T

The COMSOL Multiphysics server is only connected to the client for a short period 
of time. If no updates have been issued during this period the server shuts down the 
port and starts waiting for the client to reconnect. Once a new operation is issued on 
the client side the connection is reestablished. You can control the time before the 
server disconnects with the -timeout option. By default the server waits 10 minutes 
before it disconnects.

S A V I N G  A N D  L O A D I N G  M O D E L S  O N  T H E  S E R V E R

For large models run on the 64-bit COMSOL Multiphysics server, memory available 
on the client might not be sufficient to save the model. Therefore we have 
implemented the ability to load and save a model directly on the computer where the 
COMSOL Multiphysics server is running. Please note that the file systems accessible 
on the COMSOL Multiphysics server might be different than the ones where your 
COMSOL Multiphysics client is running. These options are available when you are 
running COMSOL Multiphysics client/server on different computers by going to the 
File menu and choosing Open and Save As.

R U N N I N G  T H E  C O M S O L  M U L T I P H Y S I C S  S E R V E R  W I T H I N  M AT L A B  

R E M O T E L Y

On Windows and the Macintosh you must have access to a display to run MATLAB. 
Thus to run the COMSOL Multiphysics server within MATLAB on a remote 
Windows or Macintosh computer, you must sit down at the computer and log in, or 
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you need a remote login tool with display capabilities such as NetMeeting or Remote 
Desktop. 

On Linux and Sun you can start MATLAB remotely as long as you have access to a 
display pointed to by the DISPLAY variable. Start the COMSOL Multiphysics server 
within MATLAB by typing comsol server. You must start MATLAB in Windows by 
using COMSOL with MATLAB on the Start menu, on a Mac by running the COMSOL with 

MATLAB application, or on Linux and Sun platforms by typing the command comsol 
matlab.

Connecting Standalone COMSOL Multiphysics to a Server

It is not necessary to set up a client-server connection from the start when you run 
COMSOL Multiphysics. You can connect COMSOL Multiphysics running in 
standalone mode to a COMSOL Multiphysics server or to MATLAB at any time. To 
do this use the Client/Server/MATLAB menu in the File menu.

When a standalone version of COMSOL Multiphysics is connected to a server, data 
the solvers need is transferred to the server, and the previously standalone COMSOL 
Multiphysics becomes a COMSOL Multiphysics client.

C O N N E C T I N G  T O  M AT L A B

To connect to MATLAB, use the menu item Connect to MATLAB. This launches 
MATLAB and starts a server in MATLAB. Then the standalone COMSOL 
Multiphysics is connected to this server. 

The Connect to MATLAB menu item always launches a new MATLAB session. To 
connect to an already running session of MATLAB, first go to MATLAB and issue the 
command comsol server. This starts a COMSOL Multiphysics server in MATLAB. 
Then use the Connect to Server menu item to connect to this server.

C O N N E C T I N G  T O  A  S E R V E R

To connect to a COMSOL Multiphysics server, use the menu item Connect to Server. 
This opens a dialog box where you can enter the server and login information.
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The user name and password are the ones you used when starting the server, and the 
port number is printed by the server when it is started.

D I S C O N N E C T I N G  F R O M  A  S E R V E R

You can close the connection to the server or MATLAB using the menu item 
Disconnect from Server/MATLAB. Doing so transfers all data from the server to the client 
and makes it a standalone version of COMSOL Multiphysics.

Keep in mind that if you close the connection from a server running on another 
computer and the client computer has less memory, there might not be enough 
memory on the client computer for all data. This can in particular happen if you have 
a large model open at the time you close the connection. The solution data resides on 
the server. This data is transferred to the client, and there must be enough memory on 
the client computer to complete this transfer.
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L o g i n  I n f o rma t i o n  and S e c u r i t y

Login Information

When you start a COMSOL Multiphysics server for the first time, the Set Login 

Information window appears. Select a user name and a password, which COMSOL 
Multiphysics then uses in communications between the COMSOL Multiphysics client 
and the server. You must also specify a matching user name and password on the 
Settings page in the Model Navigator, which opens when you start the COMSOL 
Multiphysics client. The software writes this login information in the subdirectory 
.comsol/ver35a/login in your home directory. On Mac OS X this login information 
is located in Library/Preferences/COMSOL/ver35a/login in your home directory.

Client/Server Security Issues

COMSOL Multiphysics can operate in a client/server mode where COMSOL 
Multiphysics runs as a separate client and a server. COMSOL Multiphysics uses a 
TCP/IP connection to send data between the server and the client.

Always make sure that untrusted users cannot access the COMSOL login information. 
Thus you must protect the file .comsol/ver35a/login in your home directory. This 
is important when using COMSOL Multiphysics’ client/server feature.

Once you start a COMSOL Multiphysics server, a person with access to your login 
information could potentially connect to your COMSOL Multiphysics server. By 
default, only a single COMSOL Multiphysics client can connect to a server. If you 
disconnect from the server, you must once again run the comsol server command 
to make further connections. When a COMSOL Multiphysics client connects or 
disconnects from a remote computer, the COMSOL Multiphysics server displays a 
message. The connection from the client to the server is made with the TCP protocol.

The server and client are mutually authenticated using a challenge handshake 
authentication protocol, which means that login information cannot be easily obtained 
by someone eavesdropping on the network communication. The TCP connection 
between the client and the server is otherwise not encrypted. If you require encryption 
of the TCP connection, you can use third-party software based on protocols such as 
SSH or IPSEC.
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Runn i n g  COMSOL i n  Pa r a l l e l

COMSOL supports two mutual modes of parallel operation. One mode is based on 
the distributed memory model and runs on several nodes on a Linux or Windows 
cluster; see “Distributed-Memory Parallel COMSOL” on page 72. The other mode, 
described below, is based on the parallel shared memory model.

Shared-Memory Parallel COMSOL

Most multiple-processor machines and dual-core/multicore machines support the 
shared memory model, however, it is not supported by several nodes on a cluster. The 
solvers, assembly, and meshing in COMSOL Multiphysics benefit from shared 
memory parallelism.

N U M B E R  O F  P R O C E S S O R S  U S E D  B Y  S H A R E D  M E M O R Y  C O M S O L

On Linux and Sun, the COMSOL software runs on one processor by default. On 
Windows, COMSOL uses the environment variable NUMBER_OF_PROCESSORS . On 
Intel Mac, the number of processors is detected through the sysctl command. If you 
have a parallel machine that COMSOL supports, you can override the default with the 
option -np <number of processors>.

Note: You can set the environment variable COMSOL_NUM_THREADS instead. It is 
overridden by the option -np.

Note: MATLAB 2007a supports multiple processors. The support is activated on the 
General page of the Preferences dialog box, which you reach from the Options menu. 
When disabled, this setting overrides the processor settings in COMSOL.

O P T I M I Z I N G  P R O C E S S O R  U S A G E

Depending on how loaded your machine is, you can control how COMSOL uses the 
available processors. Apart from the default mode there are three modes of operation 
that you control with the option -mpmode <multiprocessor mode>. The throughput 
mode (-mpmode throughput) is expected to give the best performance when several 
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different processes are running actively at the same time as COMSOL. The 
turnaround mode (-mpmode turnaround) and owner mode (-mpmode owner) 
typically provide the best performance when no other processes than COMSOL are 
active. The owner mode provides the highest performance in most cases, but the only 
way to find out is to experiment with the different modes.

Note: You can set the environment variable COMSOL_MP_MODE instead. It is 
overridden by the option -mpmode.

B E N E F I T S  O F  R U N N I N G  C O M S O L  S H A R E D  M E M O R Y  P A R A L L E L

All iterative solvers and smoothers except Incomplete LU are parallelized. Some 
smoothers have blocked versions. The blocked versions are usually more parallel than 
the nonblocked versions. The finite element assembly also runs in parallel. Usually the 
speedup depends on the problem size; problems using a lot of memory usually have 
better speedup.

The PARDISO sparse direct linear solver runs in parallel. It is available on Windows, 
Linux, and Intel Mac. The SPOOLES sparse direct linear solver also runs in parallel on 
Windows, Linux, Sun, and Intel Mac. The direct solvers UMFPACK and TAUCS both 
benefit from shared memory parallelism; however, to a lesser extent than PARDISO 
and SPOOLES.

The free mesher in 3D runs in parallel over the faces and subdomains of the geometry 
object being meshed. For this reason, the speedup when running on several processors 
depends strongly on the domain partitioning of the corresponding geometry. Meshing 
a geometry with only one subdomain, such as an imported CAD part, gives almost no 
speedup at all. On the other hand, meshing a geometry with several subdomains, such 
as an imported CAD assembly with many parts, can give significant speedup, especially 
if the number of elements in the mesh is large.

The following postprocessing plots run in parallel in 3D: slice plots, isosurface plots, 
subdomain plots, boundary plots, edge plots, deformed-shape plots, and streamline 
plots. In 2D, surface plots, contour plots, and boundary plots, and deformed-shape 
plots run in parallel.

A significant part of the parallel speedup in computations comes from functions of the 
type BLAS (basic linear algebra subprogram; see the next section). If you want to run 
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the software in parallel, it is important that the BLAS library you use supports 
parallelism. The ACML, MKL, and Sun performance libraries run in parallel.

Note: These libraries run in parallel but might not be the best choice for your 
processor type.

Running in parallel usually requires extra memory. If you run out of memory, try to 
set the -np option to a lower number. The speedup depends on the processor load. 
For instance, if your system has m processors and n of them are used by other active 
programs, do not set the -np option to a number that is greater than m − n. The 
reason is that the programs compete for the same resources, which slows all of them 
considerably.

COMSOL and BLAS

BLAS is a set of functions for basic linear algebra operations. Vendors often supply 
BLAS libraries optimized for their hardware. A large portion of the computational 
engine in COMSOL relies on BLAS. Included with COMSOL are the BLAS libraries 
ACML (AMD Core Math Library) optimized for AMD processors with SSE2 support, 
MKL (Math Kernel Library) optimized for Intel processors, and ATLAS 
(Automatically Tuned Linear Algebra Software). On PowerPC Mac, COMSOL relies 
on vecLib, which is installed on the system. Sun provides the Sun Performance Library 
with Sun Studio. Use the Sun Studio 11 version on 64-bit Solaris and the Sun Studio 
8 version on 32-bit Solaris. You can also supply your own BLAS library optimized for 
your hardware. By default COMSOL automatically tries to detect an appropriate 
BLAS library. The defaults in COMSOL are:

• MKL on Intel processors (Linux, Intel Mac and Windows).

• ACML on AMD processors that support SSE2 instructions; otherwise ATLAS is 
used (Linux and Windows).

• ATLAS on Sun.

• vecLib on PowerPC Mac.

You can override the default with the option -blas. Valid options to the -blas option 
are:

• auto—same as not using the option (Linux, Windows, Sun)

• mkl—selects the MKL library (Linux, Intel Mac, Windows)
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• atlas—selects the ATLAS library (Linux, Windows, Sun)

• acml—selects the ACML library (Linux, Windows)

• sunperf—selects the Sun Performance Library (Sun)

• veclib—selects the vecLib Library (Intel Mac and PowerPC Mac)

• path—tries to load the library specified by the environment variable 
COMSOL_BLAS_PATH. The library must support the standard FORTRAN BLAS 
interface (Linux, Windows, Sun, Mac)

If the library you want to use is unavailable or incorrectly installed, COMSOL switches 
back to the default library. 

Note: Instead of starting COMSOL with the -blas option, you can set the 
environment variable COMSOL_BLAS_LIBRARY. The option -blas overrides the 
environment variable.

U S I N G  A  D I F F E R E N T  B L A S  L I B R A R Y  T H A N  T H E  D E F A U L T

If you want to use a different BLAS library than the default, make sure that COMSOL 
can find the library. The simplest way for COMSOL to find a library is to put it in 
COMSOL35a/lib/ARCH where ARCH is the architecture (glnx86, glnxa64, glnxi64, 
win32, win64, maci32, maci64, macosx, sol2, or sol64) or somewhere in the 
standard search path.

Note: You must also provide the path to any sublibraries needed by the library.

You can also set the search path to point to the directory where the library is installed. 
To do so, use the environment variable LD_LIBRARY_PATH on Linux and Sun 
(LD_LIBRARY_PATH_64 on 64-bit Sun), or the environment variable PATH on 
Windows.

If you use the Sun Performance Library on Sun, that vendor recommends you change 
the default stack size to 4 MB for 32-bit Solaris and 8 MB for 64-bit Solaris. COMSOL 
assumes that Sun Performance Library is installed in /opt/SUNwspro/. Otherwise you 
must provide the search path.
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Distributed-Memory Parallel COMSOL

The Linux and Windows versions of COMSOL support a distributed memory mode. 
The distributed mode starts a number of computational nodes determined by the -nn 
<number of nodes> option to the COMSOL command. Each computational node 
is a separate process running a COMSOL instance. A computational node is not the 
same as a physical node (computer), but they can coincide. When running in 
distributed mode, COMSOL uses MPI for communicating between the processes in 
the distributed environment.

Figure 2-1: Schematic of a cluster with 3 physical nodes (computers) with 4 processors each.

The distributed-memory mode can be combined with COMSOL’s ability to benefit 
from the shared-memory model. Use the -nn option in combination with the -np 
option. The -nn option directs COMSOL to start up a number of computational 
nodes that communicate using the distributed-memory model. The -np option directs 
each computational node to use a certain number of processors. See the section 
“Number of Processors Used by Shared Memory COMSOL” on page 68 for details 
about the -np option.

For the schematic in Figure 2-1, you can choose any number of computational nodes 
between 1 and 12 by specifying the -nn option. Each node, in turn, can use between 
4 and 1 processors, as specified by the -np option. By default, COMSOL uses as many 
processors as are available on each physical node for shared-memory parallelism on 
Windows. This is suboptimal if the number of computational nodes is not the same as 
the number of physical nodes. Therefore we recommend that you explicitly set the 
number of processors. For the schematic example, if you run 6 computational nodes 
(-nn), the optimal value for number of processors (-np) is 2. The number of 
processors used is nn*np.

For the same example, assuming you are the sole user of the system for the duration of 
the computation and that your problem requires a lot of memory, set -nn 3 -np 4. 
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If, on the other hand, your problem is small, set -nn 12 -np 1. This way you make 
the best use of shared-memory and distributed-memory parallelism for each problem.

You do not need a cluster to benefit from COMSOL’s ability to utilize the 
distributed-memory model. On a multiprocessor computer you can use the -nn option 
to start multiple computational nodes. This can be useful for small-sized parameter 
sweeps, for example. Make sure that the number of computational nodes times the 
number of processors does not exceed the number of available processors; otherwise 
performance deteriorates significantly. See the section “Benefits of Running 
COMSOL Shared Memory Parallel” on page 69.

Note: In client/server mode, the computer or cluster acting as server must be 
accessible from the client through a TCP/IP connection. If you are not able to 
connect to the server, you can use the comsol batch command to solve models on 
the cluster or do parametric sweeps.

R U N N I N G  D I S T R I B U T E D - M E M O R Y  P A R A L L E L  C O M S O L

Windows Compute Cluster Server 2003
Make sure that you have installed Windows Compute Cluster Server 2003. Running 
distributed COMSOL on other noncluster Windows versions is not supported.

On Windows we recommend that you start a COMSOL server (see “Running 
COMSOL Multiphysics Client/Server” on page 62) or run a COMSOL batch 
command from the Compute Cluster Job Manager. By default COMSOL uses as many 
processors as are available on each physical node for shared-memory parallelism on 
Windows. Therefore it is best to explicitly set the number of processors. Make sure that 
you set the Windows Compute Cluster Server 2003 working directory to point to the 
comsol command directory (<path to COMSOL install directory>\bin). The 
install directory must be shared between the nodes on your cluster.

COMSOL server   When you create a COMSOL server cluster job, you must set a 
preference directory reachable from all nodes to avoid problems with the server login; 
see “The COMSOL Command” on page 52 and “Login Information and Security” 
on page 67. You can generate the preferences by starting COMSOL server once on 
the head node using the command

comsolserver.exe -prefsdir <path to common directory with 
  preferences>
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and then selecting the Remember password check box in the login dialog box.

When you start the COMSOL server on the cluster, the port number will be written 
to standard output, so you must set a standard output file and a standard error file for 
the cluster job. To start a COMSOL server, schedule a job with one of the following 
commands:

mpiexec comsolserver.exe -nn -1 -np 1 -prefsdir <path to common 
  directory with preferences>
mpiexec comsolserver64.exe -nn -1 -np 1 -prefsdir <path to common 
  directory with preferences>

The argument -1 indicates that the number of computational nodes is decided at the 
mpiexec launch. You must be able to access the IP address of the COMSOL server 
from your COMSOL client computer.

COMSOL batch   Schedule a job with one of the commands

mpiexec comsolbatch.exe -nn -1 -np 1 <filename>
mpiexec comsolbatch64.exe -nn -1 -np 1 <filname>

to run a COMSOL batch on a number of computational nodes given by mpiexec. For 
further information about the mpiexec command and the Windows Compute Cluster 
Server 2003, consult the documentation that was shipped with the product and the 
online manuals.

Windows HPC Server 2008
Make sure that you have installed Windows HPC Server 2008, then follow the 
instructions for Windows Compute Cluster Server 2003 on page 73.

Running on Linux
There are several implementations of MPI. COMSOL is shipped with the Intel MPI 
library but should also support most MPI implementations based on MPICH2. We 
recommend that you use the default Intel MPI library. For running COMSOL on a 
computer that has MPICH2 installed, COMSOL also has a compatibility mode that 
you can activate by adding the option -mpi mpich2. When using this option both the 
variables PATH and LD_LIBRARY_PATH must include your MPI implementation. It is 
also possible to use other MPI libraries based on MPICH2 using the option -mpipath 
<path to shared library>.

In order to start Intel MPI, have a file named .mpd.conf in your home directory to 
which you alone have access. This file should contain the single line

secretword = <your secret word here>
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Before you start COMSOL, you must initialize the MPI environment. A so called 
multiprocessing daemon (MPD) must run on each computer node that you intend to 
use. To start MPD on several computer nodes, type

comsol -nn <number of computer nodes> mpd boot -f <filename>

The file <filename> should contain the names of the computer nodes that you intend 
to use. The file may contain more computer nodes than you actually intend to use. As 
an alternative to using the -f <filename> option, you can put the list of computer 
nodes in a file named mpd.hosts in your home directory. Start distributed COMSOL 
with the -nn option. For example, type

comsol -nn <number of computational nodes> server

to start a COMSOL server running on a specific number of computational nodes. The 
number of computational nodes can exceed the number of computer nodes. Avoid 
starting more computational nodes than the total number of processors that you have 
available. When you have finished using distributed COMSOL, you should take down 
the all MPDs. Type the command

comsol mpd allexit

stop all MPDs. To obtain more information about the comsol mpd commands, add 
the -h option to the commands, for example, comsol mpd boot -h.

Start MPD on a single computer with the command

comsol mpd mpd &

This is useful when running all computational nodes on a single multiprocessor 
computer or when you have difficulties attaching computational nodes because of 
firewalls. In the second case you can start an MPD on each node and attach them by 
specifying the main port and host. Use 

comsol mpd trace -l

and

comsol mpd mpd --port <the port number reported> --host <the 
    hostname reported>

You can also start COMSOL with the -clustersimple option. This option 
automatically starts and terminates the MPD daemon. It uses the mpd.hosts file in 
your home directory to determine what computational nodes to use.

Usually COMSOL only uses a display for one of the processes. However, if possible, 
the -clusterdisplay option starts a display for every process.
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Starting Distributed COMSOL—Linux Examples
Start an MPD on a single computer. Then start distributed COMSOL on two 
computational nodes each using three processors, and finally stop the MPD:

comsol mpd mpd &
comsol -nn 2 -np 3
comsol mpd allexit

Start three MPDs on computer nodes with names defined in the file myhosts. Then 
start a distributed COMSOL server on three computational nodes, and finally stop the 
MPDs. First make sure that you can connect to all the computers with ssh without 
having to use your password (see the man pages for ssh). Also make sure that all 
computers have access to the same COMSOL installation and that they are using the 
same Linux version.

comsol -nn 3 mpd boot -f myhosts
comsol -nn 3 server
comsol mpd allexit

Start four computational nodes on hosts listed in the file mpd.hosts using distributed 
COMSOL and simplified start:

comsol -nn 4 -clustersimple

U S I N G  T H E  D I S T R I B U T E D  VE R S I O N  I N S I D E  M AT L A B

Running the distributed version in MATLAB is equivalent to running in client/server 
mode.

B E N E F I T S  O F  R U N N I N G  C O M S O L  I N  A  D I S T R I B U T E D  M O D E

COMSOL runs parameter sweeps using the distributed mode. There are two ways of 
running distributed parameter sweeps. First, the parametric solver available from the 
Solver Parameters dialog box runs in distributed mode. Second, the Parametric Sweep 
dialog box on the Solve menu lets you run distributed parameter sweeps using any 
solver. These two features are also available in the COMSOL Batch mode; see 
“COMSOL Batch arguments” on page 54. In addition, the Geometric Parametric 

Sweep dialog boxes on the File menu lets you perform geometric parameter sweeps 
using the bidirectional interfaces to SolidWorks® and Autodesk Inventor® using the 
CAD Import Module. The parametric solver can run parametric sweeps from the 
command line in MATLAB. The parametric sweep feature is only available from the 
graphical user interface.
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